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1.

1.1.

1.2.

1.3.

Introduction

Purpose

The 8100 Platform Manual provides a high-level overview of the key hardware and
software components necessary to configure and use the following 8100 platforms:

e A50 e A604
e A100 e A750
e A200 e B041
e A300 e BO051
e A304 e B100
e A400 e B200
e A500 e B300
e A600 e B500

e B502

e B600

e B750

The Figures in this manual are for illustrative purposes only; your actual platform may
look different.

Intended Audience

This manual is intended for those who have a working knowledge of wireless
communication equipment, and are familiar with the automated testing of mobile
devices. You should also be familiar with the 7est Managerand the TestDrive GUI
environment. For details on operating Test Manager, refer to the 7est Manager User
Manualbefore proceeding. For details on operating TestDrive, refer to the ULTS User
Manualbefore proceeding.

Before You Get Started

Before getting started with this guide, ensure the test system is powered-up. The
Controller PC is shipped with the appropriate 7est Executive software installed.
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1.4. Accessing the Documentation

There are three ways to access this document from the Controller PC:
1. Windows Explorer

2. Test Manager

3. TestDrive ULTS

These methods of accessing the documentation are described in detail in the following
sections.

1.4.1. Accessing the Documentation from Windows Explorer
Access this Manual offline by navigating to C:\Program Files\Spirent

Communications\Test Manager\Manager\Platforms\8100-xxxx\Platform
Manual.pdf through Windows Explorer, as shown in Figure 1-1.

-iBix
File Edit ‘iew Favorites Tools  Help | :,"
G Back - \_') - le 7’ ) search [{ Falders E'

Address I_J C:YProgram Files\Spirent Communications| Test ManageriManager!Platforms|g100-4300 j Go
Folders ¥ | _Mame -~ size | Type

) online Services ;| ) Calibration Filz Falder

|)5RE058v1 Configuration Files File Folder

3 Outlook Express .

) Perfarce IE'] 021,500 &100-A300 Platform Installation.seq 22KE TestStand Se

- 347 KB Adobe Acrob

) QuickTime

) ] |2] PlatFarm,xsd 6 KB ®ML Schema

) Rainbow Technologies =k i o 0

ﬂ Real _ /= Rack Setup Guide, p 347 KB Adobe Acral

) RealyhC

) SigmaTel

) Sony
ﬂ Spirent Cornmunicakions =
JE1 | &= | i

Figure 1-1: Windows Explorer

1.4.2. Accessing the Documentation from Test Manager

Access this Manual from the Test Manager menu by selecting
Help»Platforms»8100-xxxx>Platform Manual.pdf, as shown in Figure 1-2.
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7w Test Manager

File  Edit  Yiew Ewecute  Repork

D‘E‘Hﬁ3|)¢ 3 @& » Test Manager

File Cabinet

Modules

= 1 Hodes) [ Fofoms ]

Repart Engines »

Suite Files

About, .,

Figure 1-2: Opening the Manual from Test Manager

You can also access this document by using the Test Manager Toolbar shortcut, as
shown in Figure 1-3.

Test Manager

Modules

Report Engines | Rack Setup Guide u

Figure 1-3: Opening the Manual from the Toolbar Shortcut

1.4.3. Accessing the Documentation from TestDrive

Access all User Documentation for the ULTS test theme from TestDrive by selecting
Help>User Documentation, as shown in Figure 1-4.

CFile Edit View Configure Execute Window [Help]
D-Z-H % MAX ||

User Documentation

Password

About

Figure 1-4: Opening the Manual for the ULTS Test Theme
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1.4.4. Accessing LTE Documentation from the Desktop

Access all setup guide documentation for the LTE test systems by navigating to:
C:\Users\Public\Desktop\Spirent Manuals, as shown in Figure 1-5.

. C:Users' Publich,Desktop',Spirent Manuals

O O | . = Spirent Manuals - - @J I Search Spire
Organize *  Include inlibrary = Sharewith = Burn RMew Folder

e Eovarites - Mame “ | Drate modified | Type | Size: |
Bl Deskiop . LTE Platform Setup Guides 4/20{2012 6:55 PM File Folder
8 Downloads T8 nirAccess C2K 420{2012 4145 FM Shertedt 3KB
=2 Recent Places I8 OMA-LTE Mability User Manual, pdf 424(2012 1126 PM Sharkedt IKE

- Libraries Ef] Data Retry - LTE User Manual, pdf 41242012 1:26 PM Sharteuk JKB
@ Documents
J’ Tusic
[&] Pictures
B videos

Figure 1-5: Accessing LTE Documentation



2. Associated Hardware

2.1. 8100-A50 Platform

The 8100-A50 platform, shown in Figure 2-1, is the Base UMTS Test Platform. The bench-
top platform supports UMTS Functional testing via the 8100 Development Libraries, and
UMTS Data Throughput (3G only). For details on connecting the cables for this

configuration, refer to the 8700-A50 Setup Guide.

i

=
2
€=
&=
[ m

SR2420

i —— [ [
! — e |

Controller PC

Client Laptop

Figure 2-1: A50 Platform Instrument Diagram

NOTE: The Client Laptop running the Spirent Data Client Software is optional for the
8100-A50 base platform. Contact your Regional Sales Manager to purchase the pre-

configured Client Laptop.
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2.2. 8100-A100 Platform

The 8100-A100 platform, shown in Figure 2-2, is the entry level UMTS test platform with
RF Impairments. It supports UMTS Data Throughput (3G only), and UMTS Functional
Testing via the 8100 Development Libraries. For details on connecting the cables for this
configuration, refer to the 8100-A100 Setup Guide.

Controller PC

Client Laptop

’ = -

<8 @c

Figure 2-2: A100 Platform Instrument Diagram
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2.3.

8100-A200 Platform

The 8100-A200 platform, shown in Figure 2-3, is the expanded UMTS test platform with
RF Impairments. It supports UMTS Data Throughput (2G & 3G), and UMTS Functional
Testing via the 8100 Development Libraries. For details on connecting the cables for this
configuration, refer to the 8100-A200 Setup Guide.

O

"

Client Laptop

Figure 2-3: A200 Platform Instrument Diagram



8 [ 8100 Platform Manual

2.4. 8100-A300 Platform

The 8100-A300 platform, shown in Figure 2-4, is the expanded UMTS test platform with
RF Impairments with the Expansion Unit for multi-module support. It supports UMTS Call
Reliability, UMTS Data Throughput (2G & 3G), and UMTS Functional Testing via the 8100
Development Libraries. For details on connecting the cables for this configuration, refer
to the 87100-A300 Setup Guide.

e
2@ i

—
o | SRENT SRE0SE PRLT coHRURITION LT N Nl

e
O dmmrn SRSOSE FELT COMMMUBATION LT . l [

e Controller PC

......._._._'.;:....,..."m““”|

Al |
-.-
‘e
CH

i

. .
T agiken g9t

______ Client Laptop

I onnnnnnn §
[

a
o
'

Figure 2-4: A300 Platform Instrument Diagram
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2.5.

8100-A304 Platform

The 8100-A304 platform, shown in Figure 2-5, is the enhanced UMTS Four Channel test
platform with RF Impairments. It supports UMTS Call Reliability, UMTS Data Throughput
(2G and 3G), UMTS Simulated Drive Test, and UMTS Functional Testing via the 8100

Development Libraries. For details on connecting the cables for this configuration, refer

to the 87100-A304 Setup Guide.

.44__

= I!III!III

=
Il

e % iiiiEﬂ
e

] [ SEFENT  SRS038 TEST COMPIARATICN LRI

|iIII}IIiIIiiIi}II]IIiilii iifiiiiiiiii

£
i
z
£

Controller PC

Client Laptop

Figure 2-5: A304 Platform Instrument Diagram
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2.6.

8100-A400 Platform

The 8100-A400 platform, shown with the GSS6700 GNSS Simulator in Figure 2-6, is the
ULTS ADS Test Platform. It supports the Spirent ULTS-ADS (A-GPS Development System)
used to test A-GPS chipsets and modules before they are fully integrated into a wireless
device. The 8100-A400 platform supports the GSS6560 (For existing customers only. this
option is no longer for sale.), the GSS6700, or the GSS8000 GNSS Simulator.

Note that support for the STR4500 will be discontinued in the upcoming release. Existing
STR4500 customers need to contact Spirent to replace their STR4500 unit with a
GSS6700 unit.

The ADS Software Development Kit (ADS-SDK) is provided to develop the custom
interface for the Device under Test. An external relay is used for time synchronization
purposes. For details on connecting the cables for this configuration, refer to the 8700-
A400 Setup Guides.

CISCO ROUTER

e

ol

seEn ¥ e . T

To Mobile GPS < C'’

Antenna

ULTS-ADS |
Switch

Figure 2-6: 8100-A400 Platform Configuration
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2.7.

8100-A500 Platform

The 8100-A500 platform, shown with the GSS6700 GNSS Simulator in Figure 2-7, is the
Validated ULTS RF Test Platform. It is Spirent’s flagship A-GPS test configuration used to
test A-GPS enabled mobile devices. It supports RF Performance, Signaling Conformance
(including SUPL), and Over-the-Air (OTA) Test Scenarios. This platform also supports GPS
Service Interaction Functional Test Scenarios via the 8100 Development Libraries. The
8100-A500 supports the GSS6560 (For existing customers only. this option is no longer
for sale.), the GSS6700, or the GSS8000 GNSS Simulator. For details on connecting the
cables for this configuration, refer to the 8700-A500 Setup Guide.

qqqqqqqq

|
&

:
@

CINES)

<@ @O

Figure 2-7: 8100-A500 Platform Configuration

NOTE: A Client Laptop running the Spirent Data Client Software (not shown) is
required to run GPS Service Interaction Tests on this platform. Contact your
Regional Sales Manager to purchase the pre-configured Client Laptop.
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2.8. 8100-A600 Platform

The 8100-A600 platform, shown with a GSS6700 in Figure 2-8, is the expanded ULTS
test platform with RF Impairments with the Expansion Unit for multi-module support. It
supports UMTS Location Test, UMTS Call Reliability, UMTS Data Throughput (2G & 3G),
and UMTS Functional Testing via the 8100 Development Libraries. The 8100-A600
supports the GSS6560 (For existing customers only. this option is no longer for sale.) the
GSS6700, and the GSS8000 GNSS Simulator. For details on connecting the cables for

this configuration, refer to the 8700-A600 Setup Guide.

Controller PC

im % 8 e i Client Lapt;-ﬁ"""-

Figure 2-8: 8100-A600 Platform Configuration
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2.9.

8100-A604 Platform

The 8100-A604 platform, shown with a GSS6560 in Figure 2-9, is the combined ULTS
and UMTS Four Channel Platform with RF Impairments. It supports UMTS Location Test,
UMTS Call Reliability, UMTS Data Throughput (2G & 3G), UMTS Simulated Drive Test, and
UMTS Functional Testing via the 8100 Development Libraries. The 8100-A604 supports
the GSS6560 (For existing customers only. this option is no longer for sale.) and the
GSS6700 GNSS Simulator. For details on connecting the cables for this configuration,
refer to the 8100-A604 Setup Guide.

Controlier PC

Figure 2-9: 8100-A604 Platform Configuration
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2.10. 8100-A750 Platform

The 8100-A750 platform shown a GSS6700 in Figure 2-10, is the entry level ULTS RF Test
Platform. It supports RF Performance, Signaling Conformance (including SUPL), and Over-
the-Air (OTA) Testing. This platform also supports GPS Service Interaction Functional Test
Scenarios via the 8100 Development Libraries. The 8100-A750 platform supports the
GSS6560 (For existing customers only. this option is no longer for sale.), the GSS6700,

or the GSS8000 GNSS Simulator.

Note that support for the STR4500 will be discontinued in the upcoming release. Existing
STR4500 customers need to contact Spirent to replace their STR4500 unit with a
GSS6700 unit.

For details on connecting the cables for this configuration, refer to the 8700-A750 Setup

Guide.

NOTE: The step attenuator shown is used only in an OTA test configuration. In
addition, the Client Laptop running the Spirent Data Client Software (not shown) is
required to run GPS Service Interaction Tests on this platform. Contact your
Regional Sales Manager to purchase the pre-configured Client Laptop.

= 0 . @
T
T o ] o |
®
. L

Controller PC

=

Slep Altenualtor

Figure 2-10: 8100-A750 Platform Configuration
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2.11. 8100-B041 Platform

The 8100-B041 platform shown in Figure 2-11, is one of the Base LTE Test Platforms. It
comes equipped with the S3110B Mobile Test Application used for comprehensive LTE
Transmitter/Receiver testing. The 8100-B041 platform supports one LTE cell. Optional
support for MIMO, Fading, and a second LTE cell are also available for this platform.

E2010%

Figure 2-11: 8100-B41 Platform Instrument Diagram
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2.12. 8100-B051 Platform

The 8100-B051 platform shown in Figure 2-12 is one of the Base LTE Test Platforms. The
8100-B051 platform supports one LTE cell. Optional support for MIMO, Fading, and a
second LTE cell are available for this platform.

For details on connecting the cables for these configurations, refer to the 8700-B051
Setup Guide.

. A Controller PC
E20103

Figure 2-12: 8100-B51 Platform Instrument Diagram
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2.13. 8100-B100 Platform

The 8100-B100 platform, shown in Figure 2-13 is the Base LTE RF Performance Test
Platform. The 8100-B100 platform supports both a single or dual cell configuration
(available via platform option). For details on connecting the cables for this
configuration, refer to the 8100-B100 Setup Guide.
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Figure 2-13: 8100-B100 Platform Instrument Diagram
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2.14. 8100-B200 Platform

The 8100-B200 platforms are shown in Figure 2-14. The 8100-B200 platform supports
both LTE single and dual cell configurations. The 8100-B200 platform supports LTE Data
Performance, LTE Data Retry, and LTE-InterRAT (CDMA and/or UMTS) modules.

For details on connecting the cables for these configurations, refer to the 8§7100-8200
Setup Guide.

——y

.écgnt-ml-ler PC

Figure 2-14: 8100-B200 Platforms Instrument Diagram
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2.15. 8100-B300 Platform

The 8100-B300 platform is shown In Figure 2-15. The 8100-B300 platform supports both
LTE single and dual cell configurations. The 8100-B300 platform supports LTE RF
Performance, LTE Data Performance, LTE Data Retry, and LTE-InterRAT (CDMA and/or
UMTS).

For details on connecting the cables for these configurations, refer to the 87100-8300
Setup Guide.

Controller PC
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Figure 2-15: 8100-B300 Platform Instrument Diagram
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2.16. 8100-B500 Platform

The 8100-B500 Series Platform is shown in Figure 2-16. This system supports LTE
Location Testing Applications. The configuration shown in the diagram supports testing
of LTE and CDMA capable devices. Other configurations that support UMTS are available.

For details on connecting the cables for these configurations, refer to the 87100-B500
Setup Guide.
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Figure 2-16: 8100-B500 Platform Instrument Diagram
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2.17. 8100-B502 Platform

The 8100-B502 Series Platform is shown in Figure 2-17. This system supports Multi-Cell
LTE (up to 4 LTE Cells) Location Testing Applications. The configuration shown in the

diagram below supports testing of LTE-only devices. Other configurations that support
UMTS and CDMA are available.

For details on connecting the cables for these configurations, refer to the 8700-8502
Setup Guide.
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Controller PC
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(Optional)

Figure 2-17: 8100-B502 Platform Diagram
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2.18. 8100-B600 Platform

The 8100-B600 Series Platform is shown in Figure 2-18.This platform supports LTE single
and dual cell configurations, LTE RF Performance, and LTE Location Test Applications.

For details on connecting the cables for these configurations, refer to the 8700-8B600
Setup Guide.
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Figure 2-18: 8100-B600 Platform Diagram
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2.19. 8100-B750 Platform

The 8100-B750 Series platform is shown in Figure 2-19. This system supports LTE
Location Testing Applications. The configuration shown in the diagram supports testing
of LTE and capable devices. Other configurations that support UMTS and CDMA are
available.

For details on connecting the cables for these configurations, refer to the 87100-8750
Setup Guide.

Cli= Laplop

Figure 2-19: 8100-B750 Platform Diagram
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2.20. Instrument Descriptions

2.20.1. User Equipment (UE)

The term “UE” denotes the User Equipment under Test. For UMTS, the UE is usually a
handset or Data Card connected to a PC or laptop.

2.20.2. SR5500 Wireless Channel Emulator

The SR5500 allows you to assess the capacity of a mobile device to mitigate multi-path
effects by emulating the delay, fast and slow fading, and path-loss characteristics of RF
mobile communication channels. The SR5500M TestKit software interface drives the
emulator, which operates through the Test Manager Graphical User Interface.

Included in the following configurations: 8100-A100, A200, A300, A304, A600, and
A604.

Optional in the following configurations: 8100-B100, B200, B300, and B500.

2.20.3. SR3420 WCDMA Network Emulator

The Spirent SR3420 is a scalable WCDMA Network Emulator. The SR3420 instrument
coupled with the AirAccess WCDMA-HS control software provides emulation of all
network components required to establish mobile data calls. It includes IP-connectivity
through the Ethernet for optional connectivity to external data servers.

Included in the following configurations: 8100-A50, A100, A200, A300, A304, A500,
A600, A604, and A750.

Optional in the following configurations: 8100-B200, B300, and B500.

2.20.4. E2010S LTE Network Emulator

The Spirent E2010S is a scalable LTE Network Emulator. The E2010S instrument coupled
with the CS8 Interactive Tester control software provides emulation of all network
components. These components are required to establish mobile data calls and include
IP-connectivity through Ethernet for optional connectivity to external data servers.

The optional second cell hardware enables the E2010S to support Multi-Cell LTE test
capabilities.

Included in the following configurations: 8100-B041, B051, B100, B200, B300, B500,
B502, and B750.
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2.20.5. SR3610 Core Network Emulator

The Core Network Emulator is a rack-mounted 1U PC that provides real-time Core
Network emulation of the UMTS wireless system. The primary function of the emulator is
to provide real-time user plane traffic (UDP/FTP/HTTP) routing to and from the UE and
Application Server.

Now optional in the following configurations: 8100-A50, A100, A200, A300, A304, A600,
and A604. Note that this HW option is only required to test PPP over PDCP for Data
Throughput.

NOTE: As of April 2010, the SR3610 is no longer included in any of the 8100 UMTS
Base Platforms.

2.20.6. SR3620 Enhanced Packet Core (EPC) Emulator

The Enhanced Packet Core (EPC) Emulator is a rack-mounted 1U PC that provides real-
time Core Network emulation of 3G/4G wireless systems. The primary function of the
emulator is to provide real-time user plane traffic (UDP/FTP/HTTP) routing to and from
the UE and Application Server.

Included in the following configurations: 8100-B051, B100, B200, B300, B500, and
B600.

2.20.7. Spirent STR4500 GPS Location Simulator

The STR4500 is a 12-channel L1 C/A code GPS Location Simulator used for Assisted GPS
(A-GPS) testing. The STR4500 is capable of replaying pre-programmed test scenarios.
TestDrive ULTS automatically configures the STR4500 through the SimPLEX/45 control
software. This software provides complete, automated UE position-location testing.

The STR4500 is no longer available for sale and will not be supported following the next
release. Existing 8100-A400 or A750 platforms customers must replace their units with
GSS6700 units.

2.20.8. Spirent GSS6560 GPS Location Simulator

The GSS6560, a 12-channel L1 C/A code GPS Location Simulator used for Assisted GPS
(A-GPS) testing. The GSS6560 features programmable parameters for customized test
scenarios. TestDrive ULTS automatically configures the GSS6560 through the SimGEN
control software. This software provides complete, automated UE position-location
testing.

The GSS6560 is no longer available for sale, but can be used by existing customers on
the 8100-A400, A500, A600, A604, and A750 platforms. Existing customers are
encouraged to upgrade their systems to GSS6700 units.
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2.20.9. Spirent GSS6700 GNSS Location Simulator

The GSS6700 is a single carrier (L1) with multi constellation (GPS, GLONASS, & GALILEO)
and up to 48 Channel support GNSS simulator. GSS6700 simulator can be controlled by
SimREPLAY or SimREPLAYplus or SimGEN software. ULTS supports SImREPLAYplus and
SimGEN and may add SimREPLAY support in a future release.

Optional in the following configurations: 8100-A400, A500, A600, A604, A750 and
B500..

2.20.10. Spirent GSS8000 GNSS Location Simulator

The GSS8000 is a three carrier (L1, L2, L5), multi constellation (GPS, GLONASS,
GALILEO), and 48 Channel advanced GNSS simulator. GSS8000 is controlled by SimGEN
software only.

Forthe 8100-A400, 8100-A750, or 8100-A500 systems we recommend at least twelve
Channel L1 GPS and twelve Channel L1 GLONASS as a minimum requirement to support
Assisted GLONASS (A-GLONASS) test cases.

Optional in the following configurations: 8100-A400, A500, A600, A750, and B500.

2.20.11. SR3920 Application Server PC

The Application Server uses the Windows Server 2003 Operating System. The SR3920 is
a rack-mounted 1U PC that facilitates FTP/UDP/HTTP and alternating/bi-directional
transfer capability to the Data Client PC. A Spirent Data Client Application runs on the
server remotely managed by the Spirent Data Client application located on the Controller
PC to provide this feature.

Included in the following configurations: 8100-B200 and B300.

Optional in the following configurations: 8100-A50, A100, A200, A300, A304, A600,
A604, and B500.

It is required for UMTS Data Throughput, Data Call Reliability, and Data Mobility Test
Themes. This is also optional on the 8100-A500 and A750 platforms for GPS Service
Interaction Functional Testing (via 8100 Development Libraries).

2.20.12.5R3920 V2 Application Server PC

This Application Server is the replacement for the SR3920 and uses the Windows Server
2008 operating system. The SR3920 V2 is a rack-mounted 1U PC that facilitates
FTP/UDP/HTTP and alternating/bi-directional transfer capability to the Data Client PC. To
provide this feature, a Spirent Data Client Application runs on the server remotely
managed by the Spirent Data Client application located on the Controller PC.

Included in the following configurations: 8100-B200 and B300.
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Optional in the following configurations: 8100-A50, A100, A200, A300, A304, A600,
A604, B500, and B600.

It is required for UMTS Data Throughput, Data Call Reliability, and Data Mobility Test
Themes. This is also optional on the 8100-A500 and A750 platforms for GPS Service
Interaction Functional Testing (via 8100 Development Libraries).

2.20.13.Client PC

The Client PC is a laptop that runs Microsoft Windows XP or Windows 7 32 bit OS. It
facilitates FTP/UDP/HTTP and alternating/bi-directional transfer capability from the UE-
side. A Spirent Data Client Application runs on the Data Client PC. It is remotely managed
by the Data Client Controller located on the Controller PC. The Data Client PC also
provides connectivity to support UE remote control for test automation.

Included in the following configurations: 8100-A100, A200, A300, A304, A600, A604,
B100, B200, and B300 (optional on the 8100-A50 and B0O51 platforms).

This is also optional on the 8100-A500, A750, B500, and B600 platforms for GPS Service
Interaction Functional Testing (via 8100 Development Libraries).

Note that Spirent Data Client software is required for GPS Service Interaction. You have
the option of either buying a Data Client PC loaded with the software, or purchasing the
software separately and installing it on your current PC.

2.20.14. Agilent 8960 Wireless Communications Test Set (Optional)

The Agilent 8960 is used to implement GPRS/EDGE air-interface specifications for base
stations. This includes functions such as mobile registration, mobile and base station-
initiated call connect and disconnect, call handoffs, and test modes.

Optional in the following configurations: 8100-A200, A300, A304, A600, and A604
(required for UMTS Data Throughput, if 2G testing is needed).

2.20.15. Agilent 3499A Switch/Control System

The Agilent 3499A Switch/Control System provides a high-speed, high-density
electronic/optical switching solution for automatic test engineering applications. This
module can accommodate up to five plug-in modules, routing up to 200 channels.

Included in the following configurations: 8100-A200, A300, A500, A600, and A604.

2.20.16. Agilent EPM-P Series Power Meter

The Agilent EPM-P series power meter is designed for peak, average, peak-to-average
ratio, and time-gated measurements. The peak and average power sensor is provided to
complete measurements.

Included in the following configurations: 8100-A200, A300, A500, A600, and A604.
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Optional in the B500 configuration.

2.20.17. Agilent U2001A USB Power Sensor

The Agilent U2001A USB power sensor is used for calibration of the Spirent System. This
power sensor is used in conjunction to with a signal source to determine downlink the
insertion losses between network emulators, interference generators, and the device
under test. It is also used to determine uplink insertion loss between the device under
test and measurement devices such as a spectrum analyzer. The power sensor is not
used for test case measurements.

Included in the following configurations: 8100-B100, B200, B300, and B600.

2.20.18. Ethernet Router

The Ethernet Router allows Ethernet communication with all instruments in the system. If
connected to an existing network, it also provides a private network that isolates the
instruments from external access. The router can operate with or without a connection to
a corporate LAN or WAN.

Included in all configurations.

2.20.19. Ethernet Switch

The Ethernet Switch increases the numbers Ethernet connections in the system.

Included in the following configurations: 8100-A100, A200, A300, A600, and A604.

2.20.20. High-Speed Ethernet Switch

The High-Speed Ethernet Switch allows Ethernet communications with all instruments in
systems that support 4G technologies. In such systems, the Router (refer to Section
2.20.18) is not used for Ethernet communications between the instruments in the
system.

Included in the following configurations: 8100-B051, B100, B200, B300, B600, and
B500.

2.20.21. SR5058 or SR5058L Test Configuration Unit

The SR5058 Test Configuration Unit automatically manages the switching of RF
connections required for testing the UE. This allows the Mobile Device Test System to
achieve the highest level of flexibility in test coverage.

Included in the following configurations: 8100-A200, A300, and A600.
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2.20.22. SR5048 or SR5048L Test Configuration Unit

The SR5048 Test Configuration Unit automatically manages the switching of RF

connections required for testing the UE. This allows the 8100 platforms to achieve the
highest level of flexibility in test coverage.

Included in the following configurations: 8100-A500, A600, and A604.

2.20.23. SR5038 Test Configuration Unit

The SR5038 Test Configuration Unit automatically merges the output of the RF Downlink
channels for the Enhanced UMTS Four Channel Test Platform. This allows the 8100
platform to support advanced network topologies test methodology.

Included in the following configurations: 8100-A304 and A604.

2.20.24. SR8078 Test Configuration Unit

The SR8078 Test Configuration Unit automatically merges the output of the RF Downlink
channels for the LTE Test Platforms. This allows the 8100 platform to support advanced
network topologies test methodology.

Included in the following configurations: 8100-B200 and B300.

2.20.25. SR8048 Test Configuration Unit

The SR8048 is used to switch various test equipment and impairment generation
devices in and out of the signal paths as needed for a given test case. The SR4048 also
includes the RF amplifiers and isolation circuits necessary to meet test conditions
prescribed by wireless device testing standards.

An optional SR8048-Filter unit is required to provide optimal test conditions for the
Receiver Blocking and Intermodulation tests.

Included in the following configurations: 8100-B100 and B300.

2.20.26.SR8068 Test Configuration Unit

The SR8068 Test Configuration Unit automatically manages the switching of RF

connections required for testing LBS. This allows the 8100 platforms to achieve the
highest level of flexible test coverage.

Included in the following configuration: 8100-B500.

Optional in the following configuration: 8100-A500.



30 [ 8100 Platform Manual

2.20.27.Agilent E4438C ESG Vector Signal Generator

The Agilent ESG generator is used to provide CW tones and modulated interferers for LTE
RF performance tests. At least one ESG is required for calibration of the LTE RF
performance system.

At least one ESG is required in the following configurations: 8100-B100 and B300.

2.20.28. Agilent Spectrum/Signal Analyzer

The Agilent Spectrum/Signal Analyzer provides the measurement capability to make
advanced mobile device transmitter measurements.

Optional in the following configurations: 8100-B100 and B300.

2.20.29. Controller PC

The Controller PC runs Microsoft Windows XP (Windows 7 OS coming soon) which hosts
the Test Manager and TestDrive Software Executive. The Controller PC also hosts the
AirAccess WCDMA-HS software, that configures and operates the SR3420 and the
SR5500 TestKit software. The SR5500 software configures and operates the
SR5500/SR5500M.

Included in all configurations.

Test Manager AirAccess WCDMA-HS
SR5500 TestKit \ \ / / Spirent ADS Router
TestDrive ULTS ~ Spirent OTA SDK Router

NI TestStand — Spirent Data Client

SimPLEX/45 — \ Spirent SMLC
/ Controller PC \
CS8 Interactive Tester SImMGEN

AirAccess C2K

Figure 2-20: Controller PC Software Components
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2.21. Software Component Descriptions

The software components installed on the Controller PC are described in the following
sections.

2.21.1. Test Manager

Test Manager is the Spirent Test Executive that serves as the front-end to Test
Management and Control for all test themes except for ULTS (refer to Section 2.21.2 for
details). This is the only interactive software component needed to accomplish most
general testing. For more information on Test Manager, refer to the 7est Manager User
Manual.

Applicable on the following configurations: 8100-A50, A100, A200, A300, A304, A600,
A604, B051, B100, B200, and B300.

Test Manager must also be activated on A500 and/or A750 platforms for GPS Service
Interaction Functional Testing (via 8100 Development Libraries).

2.21.2. TestDrive ULTS

TestDrive ULTS is the Spirent Test Executive that serves as the front-end for the ULTS test
theme. This is the only interactive software component needed to accomplish most
general testing. For more information about TestDrive ULTS, refer to the ULTS User
Manual.

Applicable on the following configurations: 8100-A400, A500, A600, A604, A750, and
B500.

2.21.3. NI TestStand

Test Manager makes use of the National Instrument TestStand software as a back-end
for managing tests. TestStand is an industry-standard test management environment
that facilitates test automation and validation. Test Manager is designed to work
seamlessly with TestStand. This increases the flexibility of interactive testing and gives
an additional layer of test configurability.

Applicable on the following configurations: 8100-A50, A100, A200, A300, A304, A600,
A604, B100, B200, and B300.

NI TestStand must also be activated on A500 and/or A750 platforms for GPS Service
Interaction Functional Testing (via 8100 Development Libraries).
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2.21.4. AirAccess WCDMA-HS

The AirAccess WCDMA-HS is a GSM/GPRS/R99/HSPA software interface layer that allows
you to configure and control the SR3420 instrument. While essentially standalone
software, the AirAccess WCDMA-HS application runs in the background while general
testing requirements are met at the Test Manager front-end.

Applicable on the following configurations: 8100-A50, A100, A200, A300, A304, A500,
A600, A604, A750, BO51, B200, B300, and B500.

2.21.5. CS8 Interactive Tester

The CS8 Interactive Tester is an LTE software interface layer that allows you to configure
and control the E2010S instrument. While essentially standalone software, the CS8
Interactive Tester application runs in the background while general testing requirements
are met at the Test Manager front-end.

Applicable on the following configurations: 8100-B051, B200, B300, and B500.

2.21.6. AirAccess C2K

The AirAccess C2K is a CDMA/EV-DO software interface layer that allows you to configure
and control the SR3452/SR3462 instruments. While essentially standalone software, the
AirAccess C2K application runs in the background while general testing requirements are
met at the Test Manager front-end.

Applicable on the following configurations: 8100-B051, B200, B300, and B500.

2.21.7. SimGEN GNSS Simulation Software

SimGEN is software application that allows you to customize GPS, GLONASS, and
GALILEO (in the future) scenarios. It simulates pseudorange data for all visible satellites
and communicates with the Spirent GNSS simulator to provide real-time RF emulation of
a GPS network.

Applicable on the following configurations with GSS6560, GSS6700, or GSS8000: 8100-
A400, A500, A600, A604, A750, and B500.
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2.21.8. SimPLEX/45 GPS Simulation Software

SimPLEX/45 allows you to run test GPS scenarios on the STR4500. It simulates
pseudorange data for all visible satellites and communicates with the Spirent GPS
simulator. This communication allows for real-time RF emulation of a GPS network.

Applicable on the following configurations with STR4500: 8100-A400 and A750. The
STR4500 is no longer available for sale and will not be supported following the next
release. Existing 8100-A400 or A750 platforms customers must replace their units with
GSS6700 units.

2.21.9. SR5500 TestKit

The SR5500 TestKit is a Spirent software application that manages the configuration and
control of the SR5500M Wireless Channel Emulator. While essentially standalone
software, the SR5500 Test Kit application runs in the background while general testing
requirements are met at the Test Manager front-end.

Applicable on the following configurations: 8100-A100, A200, A300, A304, A600, A604,
B100, B200, and B300.

Refer to the SR5500M User Manualfor additional information on custom configurations
forthe SR5500M.

2.21.10. Spirent Data Client

The Spirent Data Client is a software application that manages FTP/UDP/HTTP data
transfer between the Data Client PC and the Application Server PC. The Data Client
Controller initiates all data throughput transfers, and relegates the transfer task to the
Data Client and Application Server PC. The Test Manager manages the Data Client
Controller application.

Applicable on the following configurations: 8100-A50, A100, A200, A300, A304, A600,
A604, B200, B300, and B500.

Data Client software is also required on the A500 and/or A750 platforms for GPS Service
Interaction Functional Testing (via 8100 Development Libraries).

2.21.11.Spirent SMLC Emulator

The Serving Mobile Location Centre (SMLC) is a network entity that manages the
assistance data provided to the UE during an Assisted-GNSS (A-GPS or A-GLONASS)
positioning session. The Spirent SMLC Emulator (SSE) presents a flexible solution to the
testing challenges that result from the wide range of message content permitted by 3GPP
standards. The SSE consists of a configurable state machine, providing full control of all
assistance data provided to the UE during a test session. The user-friendly configuration
interface provides a straightforward method for defining assistance data message
content.
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Applicable on the following configurations: 8100-A400, A500, A600, A604, A750, and
B500.

2.21.12.Spirent ADS Router Software Development Kit

The Spirent ADS Router Software Development Kit (“ADS SDK”) is provided with the ULTS
to facilitate development of a custom ADS Router. The ADS Router is a required software
component in a ULTS-ADS system that routes messages between the TestDrive ULTS and
the A-GPS development board. Refer to the ULTS-ADS Router SDK — Getting Started Guide
forinformation on developing a custom ADS Router using the ADS SDK as a starting
point.

The ADS SDK includes the following documents:

e Getting Started Guide.

o Message Specification for ULTS-ADS; describing the interface between TestDrive
ULTS and ADS Router.

e ADS Router sample source code.

e Simulated GPS development board source code; including RRLP and RRC position
response files.

About...
Serial Communication Settings. ..

Time Estimates and Delays. ..
Exit...

Figure 2-21: Software Information and Settings Window
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ADS Router Version 1.0.0

Figure 2-22: "About" Software Information

Applicable on the following configurations: 8100-A400, A500, A600, and A604.

2.21.13.Spirent OTA SDK Router Software Development Kit

8100-A500 or A750 with the CTIA OTA Testing option provides an interface module
called the OTA Router. This router facilitates communication between Test Drive ULTS
and various types of Positioners and Polarization Control units that are part of an
Anechoic Chamber Control Hardware. The Spirent OTA SDK Router Software Development
Kit (“OTA SDK”) is provided with the ULTS to facilitate customization of the OTA Router.
Refer to the O7A SDK User Manualfor information on how the OTA SDK helps you
customize the interface to your Anechoic Chamber control hardware.

Applicable on the following configurations: 8100-A500, A600, A604, A750, and B500.



3. General Specifications
7”‘A

3.1. 8100-A50 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)

Power Consumption (Typical): 300 to 350 Watts Continuous

3.2. 8100-A100 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (HXx W x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)

Power Consumption (Typical): 700 to 800 Watts Continuous

3.3. 8100-A200 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (H X W x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)

Power Consumption (Typical): 1100 to 1200 Watts Continuous

3.4. 8100-A300 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (H X W x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)

Power Consumption (Typical): 1100 to 1200 Watts Continuous
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3.5.

3.6.

3.7.

3.8.

8100-A304 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (H X W x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)

Power Consumption (Typical): 1350 to 1450 Watts Continuous

8100-A400 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Power Consumption (Typical w/ GSS6560/6700): 150 to 200 Watts Continuous
Power Consumption (Typical w/ GSS8000): 450 to 500 Watts Continuous

8100-A500 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)

Dimensions (Hx W x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)

Power Consumption (Typical w/ GSS6560/6700): 550 to 600 Watts Continuous
Power Consumption (Typical w/ GSS8000): 850 to 900 Watts Continuous

8100-A600 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)

Dimensions (HXW x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 c¢cm)

Power Consumption (Typical w/ GSS6560/6700): 1500 to 1550 Watts Continuous
Power Consumption (Typical w/ GSS8000): 1800 to 1850 Watts Continuous
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3.9.

3.10.

3.11.

3.12.

3.13.

8100-A604 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (HxW x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 cm)

Power Consumption (Typical w/ GSS6560/6700 & Agilent 8960): 1400 to 1450
Watts Continuous

Power Consumption (Typical w/ GSS6560/6700 only): 1100 to 1150 Watts
Continuous

8100-A750 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)

Dimensions (Hx W x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)

Power Consumption (Typical w/ GSS6560/6700): 425 to 475 Watts Continuous
Power Consumption (Typical w/ GSS8000): 725 to 775 Watts Continuous

8100-B041 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
B041 (Single LTE Cell): Power Consumption (Typical): 450 to 550 Watts Continuous
B041 (Dual LTE Cell): Power Consumption (Typical): 600 to 700 Watts Continuous

8100-B051 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
B0O51 (Single LTE Cell): Power Consumption (Typical): 800 to 900 Watts Continuous
B051 (Dual LTE Cell): Power Consumption (Typical): 950 to 1050 Watts Continuous

8100-B100 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (HxW x D): 57 x 23 x 37 inches (144.78 x 58.42 x 93.98 cm)
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3.14,

3.15.

3.16.

Power Consumption (Typical w/ ESA, ESG, & GSS): 1700 to 1750 Watts Continuous

Power Consumption (Typical w/ no ESA, ESG, & GSS): 1100 to 1150 Watts
Continuous

Power Consumption (Typical w/ GSS only): 1300 to 1350 Watts Continuous

8100-B200 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)

Dimensions (HXW x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 cm)

B200 Power Consumption — LTE Single Cell (Typical): 1150 to 1200 Watts Continuous
B200 Power Consumption — LTE Dual Cell (Typical): 1300 to 1350 Watts Continuous

8100-B300 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (Hx W x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 cm)

B300 Power Consumption — LTE Single Cell (Typical w/ ESA, ESG): 1550 to 1600
Watts Continuous

B300 Power Consumption — LTE Single Cell (Typical w/ no ESA, ESG): 1250 to 1300
Watts Continuous

B300 Power Consumption — LTE Dual Cell (Typical w/ ESA, ESG): 1700 to 1750 Watts
Continuous

B300 Power Consumption — LTE Dual Cell (Typical w/ no ESA, ESG): 1400 to 1450
Watts Continuous

8100-B500 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (HXxW x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 cm)

B500 Power Consumption — LTE Single Cell (Typical with SR5500 and SR3452
units): Up to 1520-1600 Watts Continuous.

B500 Power Consumption — LTE Dual Cell (Typical w/ SR5500 and SR3452 units):
Up to 1690-1770 Watts Continuous.
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3.17. 8100-B600 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)
Dimensions (Hx W x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 cm)

B600 Power Consumption — LTE Single Cell (Typical w/ ESA, ESG): Up to 1400-1475
Watts Continuous.

B600 Power Consumption — LTE Dual Cell (Typical w/ ESA, ESG): Up to 1520 to 1600
Watts Continuous.

3.18. 8100-B750 General Specifications

Operating Temperature: 15 — 29 ‘C (Ambient Temperature)

3.18.1. B750

Dimensions (Hx W x D): 77 x 23 x 37 inches (195.58 x 58.42 x 93.98 cm)
B750 Power Consumption — LTE Single Cell (Typical): 800 to 900 Watts Continuous
B750 Power Consumption — LTE Dual Cell (Typical): 950 to 1050 Watts Continuous

3.18.2. B750 plus CDMA

B750 Power Consumption — LTE Single Cell (Typical): 1000 to 1100 Watts Continuous

B750 Power Consumption — LTE Dual Cell (Typical): 1150 to 1300 Watts Continuous

3.18.3. B750 plus UMTS

B750 Power Consumption — LTE Single Cell (Typical): 1125 to 1225 Watts Continuous
B750 Power Consumption — LTE Dual Cell (Typical): 1300 to 1425 Watts Continuous
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3.19. Supported Operating Bands

3.19.1. UMTS Operating Bands

The following UMTS operating bands are supported on the following platforms: 8100-

A50, A100, A200, A300, A304, A500, A600, A604, and A750.

Operating DL Frequencies (MHz) UL Frequencies (MHz)
Band

I 2110-2170 1920 -1980

Il 1930 - 1990 1850 -1910

i 1805 - 1880 1710-1785

v 2110 - 2155 1710-1755

\Y 869 — 894 824 — 849

Vi 875 — 885 830 - 840

Vil 925 - 960 880 - 915

IX 1844.9 — 1879.9 1749.9 - 1784.9

XI* 1475.9 - 1500.9 1427.9 - 1452.9

* Frequency Bands only supported in the Data Throughput, Call Reliability,
and Development Library Test Packs (including GPS Service Interaction).

3.19.2. GSM Operating Bands

The following GSM operating bands are supported on the following platforms: 8100-A50,

A100, A200, A300, A304, A500, A600, A604, and A750.

Operating Band | DL Frequencies (MHz) UL Frequencies (MHz)
GSM 850 869 - 894 824 - 849

P-GSM 900 935 - 960 890 - 915

DCS 1800 1805 - 1880 1710-1785

PCS 1900 1930 - 1990 1850-1910
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3.19.3. LTE Operating Bands

The table below provides the Platform frequency information for LTE Operating Bands.

Operating Band | DL Frequencies (MHz) UL Frequencies (MHz)
1 2110-2170 1920-1980

2 1930-1990 1850-1910

3 1805-1880 1710-1785

4 2110 - 2155 1710-1755

5 869-894 824-849

7 2620-2690 2500-2570

10 2110-2170 1710-1770

12 728-746 698-716

13 777 -787 746 -756

14 758-768 788-798

17 704-716 734 -746

20 791-821 832-862

24 1525-1559 1626.5-1660.5
25 1930-1995 1850-1915

26 859-894 814-849

3.19.4. CDMA/EV-DO Operating Bands

The following CDMA/EV-DO operating bands are supported on the following platforms
when upgraded from an existing CDMA system.

Operating Band | DL Frequencies (MHz) UL Frequencies (MHz)
0 869-894 824 - 849

1 1930 -1990 1850-1910

3 832 -869 887 -925

4 1840 - 1870 1750-1780

5 421 - 494 411-484

6 2110-2170 1920 - 1980

14 1930-1995 1850-1915

15 2110- 2155 1710-1755

NOTE: For detailed information on specifications, refer to the appropriate User Manual
for your test packs.



4. Frequently Asked Questions

4.1. How Do | Calibrate the Platform?

NOTE: Location-Based Test Packs (including GPS Service Interaction Functional
Testing) require an independent calibration routine. Refer to Section 4.1.2 for
Location Based Test Pack calibration (A500 and A600 platforms only)

4.1.1. Platform Calibration (for Test Manager Based Test Packs)

The calibration routine executes from the 8100-Axxx, 8100-B Series or the 8100-B100
Platform Files.

To initiate calibration for any Test Manager based test pack (including GPS Service
Interaction Functional Testing on the A600 platform):

1. Open a platform file by selecting File>Platform File, as shown in Figure 4-1.

7w Test Manager

File  Edit Wiew  Execute  Report  Hel
| R ||

@ suite File

= LEFie

i ] SessionFie

i  Platfarm File I:

Figure 4-1: Opening the Platform File
2. Selectthe 8100-Axxx, 8100-B Series, orthe 8100-B100 tab




44 | 8100 Platform Manual

I ~loi x|
Report  Help
. b- W~ | & Nokia Mural_mike.us = 4| SessionsFiel.ses v |
.._.é // PlatformFile3.plm | > X
|E 1 - AirAccessHS
H SH3420 1P Address 192.168.0.40
! GGSM Emulator P Address 192.168.0.90
k }E 2 - SR5500
y IP Address 192168.0.7
!f E 3 - Agilent 34994 Switch Control System
i GPIB Adcress g
b SRA058v1 TCU 1 Slot Position 2
SRA058v1 TCU 2 Slot Position 3
& 4 - Agilent 4417 Power Sensor
GFIE Address 13
E 5 - Calibration
Calibration [1ata File Path C:\Program FileshSpirent Communications'Test M anager'M anagerPlatfarms a1 00-4301
Calibration wizard Click here lo execute

at I Agient Power Supply \1 Agilent 5960 \I 8100- Series \IEBIUU—ASUU

Figure 4-2: The 8100-A300 Tab

3. From the 8700-Axxxtab, initiate the calibration routine using the Calibration Wizard
platform file parameter.
Click the Click here to execute button to initiate the calibration sequence.

4, From the 8100-B Seriestab, ensure that the available instruments are set for the
configuration you want to calibrate by selecting the True/False option in the file.

5. Fromthe 8100-B Seriestab, initiate the calibration routine using the Calibration
Wizard platform parameter, as shown in Figure 4-3.
Click the Click here to execute button to initiate the calibration sequence.

FlatformsFilez . plm™ PlatformsFile3.plm* X

El 1 - Available Instruments
E20105 Enabled

& .
=] SRE07E Enabled
I
S SR3452 H1 Enabled Set Avallable =~
@ | SR3452 H2 Enabled Instruments
E] SR3420 Enabled
g E 2 - Network Configuration
=1 Metwork Configuration 1 - eModskB
* |8 3 - E20105 Broadband Wireless Test Set
E20105 IP Addiess 192.168.0.180
E E 4 - SRB078 Test Configuration Unit
g SHE07E P Address 192168.0.207
E LTE Mode Combined Mode
El 5 - 5R3452 CDMA Network Emulator
= SH3452 #1 IP Address 192168.0.6
= : :
; Duplex Mode False
& |Bl 7 - Calibration
Calibration D ata Fils Path C:A\Program FileshS pirent CommunicationshTest Managert anager\Platformsy8100-B SerieshCalibration’81
i Calibration WwWizard Click here to execute
§
@
wn
e
<
a
)
7]
&
5
=]

Figure 4-3: 8100-B Series Tab
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6. From the 8100-B100tab, initiate the calibration routine using the Calibration
Wizard platform parameter.
Click the Click here to execute button to initiate the calibration sequence.

NOTE: For all platforms; use the N-Type and SMA-Type Torque Wrenches when
removing and tightening cables.

delp
nom- |5 4] < | @ |
:_i] ¥ 4 .Plaﬁl;‘msﬁlel.plm. |

E 1-Spiwent LTE NE
2 IPAddess 152.168.0.41

E 2 - Test Configuration Unit 8048
| SRB048 1P Addiess s |
E 3 - Agilent U2001A Power Sensor

El 4 - Calibration
Calibration Data File Path C:\Program FileshS pirent Communications'T est M anagerthtanagerPlatforms'8100-B 1004Calibration &1 00-B1 01
Calibration \wfizard Click here to execute

[ Agilent Spectrum Analyzer \f Agilent ESG 2 \[ Aglent ESG 1 -\1

Figure 4-4: 8100-B100Tab

7. When the Calibration Wizard is complete, save the Platform File before exiting, as
shown in Figure 4-5.

i Test Manager

File  Edit  ‘iew  Execute  Report  Hel

.—’l’ - o ] P-
File Cabinet k

-] Modules

Figure 4-5: Saving the Platform File
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4.1.2. Location-based Test Pack Calibration
(A500/A600/A604/B500/B502 Platforms)

Calibration for the 8100-B500 platform is not supported in this release. A default
calibration file is used to compensate for the cellular path losses.

Calibration on the 8100-A500 platform is supported for both the SR8068 and SR5048.
For all platforms, the GPS calibration data is provided using the 8100-A500 procedure.

You must run the 8100-A500 calibration procedure prior to operating the 8100-B500
platform.

Refer to the Product Update for further information.
The calibration routine executes from the ULTS Test Executive.

To initiate calibration for any Location Based test pack (including GPS Service
Interaction Functional Testing):

1. Select Execute>Calibration to launch the TestDrive ULTS Calibration Wizard, as
shown in Figure 4-6.

#; TestDrive ULTS - [Suite1*]

! File Edit “iew Configure | Execute ‘Windaow  Help
M~ - | 33 ED F_E Yalidate..,

File Cahinet Run. ..

Pause
Shop 2

Calibration, ..
[iagnostics. ..

Generate Repork

Figure 4-6: Initiating the Location Based Calibration

2. The initial A500 Calibration Wizard window displays, as shown in Figure 4-7.
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Calibration Wizard

Figure 4-7: Location Based Calibration Initialization (A500 Platform)

3. Click Next and follow the steps given in the Calibration Wizard.

4. When the Calibration Wizard is complete, follow the instructions listed to configure
the ULTS system for testing.

5. The final Calibration Wizard window is shown in Figure 4-8.

Calibration Wizard

Figure 4-8: Location Based Calibration - Confirmation/Reconfiguration Window
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4.2.

6. Afterthe calibration is finished, the Calibration Datawindow displays data in tabular
and graphical format, as shown in Figure 4-9.

Calibration Data

Data Set: IAclive Calibration vl Stare a3 Reference | D ate of execution: 4/26/2005 2:25:04 PM

Path #: ID - G5M Metwork emulator to UE j
Frequency (MHz | Path Gair [dB | Calibration Data

869.50 -20.41

87750 -20.48 1920 -

8E5.50 -20.62

33,50 -20.69 -19.50 +

935.50 -20.65 i

34350 2081 -=non

951.50 -20.50 -20.40 -

958.50 -20.46

1610.00 2212 g 2080

163000 2215 S -

1850.00 -22.25 c

1870.00 -2225 g -21 B0 -

1940.00 -22E1 = |

196000 2260 & B

15980.00 2276 -22.40 -

-22.80 +
-23.20
-2360 -

-24.00

1000 1200 1400 1600 1800
Freguency (MHz)

oK I Cancel

Figure 4-9: Location Based Calibration - Calibration Data Window

The Calibration Data Window allows you to browse through the calibration data for
various signal paths by selecting the Path number. A text description of the path is
provided next to the path number. To track system drift over time, set TestDrive to record
calibration data as a Reference Calibration by clicking the Store as Reference button,
shown in Figure 4-9.

We recommend that you store the calibration data as a reference calibration the first
time the system is assembled, and any time a major component in the system changes.
Successive calibration runs are stored as the active calibration. Display Calibration Drift
by changing the Data Set to Drift. You can view the complete calibration history in the
Calibration History.mdb database.

Is there Anti-Virus Software Enabled for the System?

Yes.

Microsoft Security Essential (previously McAfee) is installed on the Controller PC with the
Virus Scan option enabled. We recommend that you manually update the virus definition
file with periodic full system scans. However, we cannot guarantee the fidelity of any
session results while the system scan is active. We suggest you initiate these scans
during off-peak execution of the system.
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